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MpwTOG 0OU OTOXOC €ival va avTiypAyelG eNakpiBwc TNV NnapakdaTtw oeAida:

O1 d1adikagiec Nou NepIypa@w NapakdaTw, gnopouv va npaypartonoinbolv kai Pe
O1aQOPETIKN OIpd, NepypdPpw TNV anAouoTepn. ZTIC NEPIOCOTEPEG aAnod TIC PUBUIOEIC
nou Kavw, Jrnopw va enePBw ava naca oTiyun. MNa Toug apxdapiouc NPOTEIVW wOTOCGO
vad dkoAouBnoouv TnV nNpoTIVOPEVN OEIpd, NPOC ano@uyn NePITTWV KABUOTEPNOEWY Kal
HaKpo-010pOBWOEWV.



Avoiyeic To Finale.
EpgavileTal To eil0aywyiko napabupo:

Kaveig kAIlk navw de€ia oto Setup Wizard

(Ma aTig unoAoineg eniAoyec Tou napabupou Ba Ta noUupe apyoTepa)

Eugaviletal To 1° napabupo diapdppwaonc Tou eyypagou:

Document Setup Wizard - Select an Ensemble and Document Style ﬂ
Select an Ensemble: Select a Document Style:
Create New Ensemble Engraved Style: Engraved Style (Maestro Font)
Handwritten Style .
Gamitan SATE + Piano Band Finale's allpurpose documert stye
Garmtan String Quartet Choral . ;
Gamitan Brass Guintet General Title, Subtitle, Compo_ser. Amanger,
Gamitan Woodwind Cluirtet Orchestral _Score;’Part, and Copyright text
Garmtan String Orchestra insers
Garitan Small Concert Band
VD Lite Battery Percussion
WD Lite Marching Percussion
SATB+Piano
Brass Trio Always: Uze This Documert
Brass Cuirtet Style vath the Selected
Brass Choir | Ensemble
Delete |
Score Page Size: |Letter (21.59x 27.94) |
* Potsit ¢ Landscape
Part Page Size:  |Lefter (21.59x 27.94) =]

{* Potsit ¢ Landscape

- ﬂpon\fnljuavol Endpevo > Arupa

EmiAéyelg (av dev ival NdN eniAeypeva):
Select an Ensemble = Create an Ensemble
Kal

Select a Document Style = Engraved Style
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>70 id10 napabupo opileic kal To PEYEBOG TNG oeAidag TnNS napTiToupac Kal TnG nNapTac
Tou BIoAIoU nou Ba PTIA&sIc apyoTepa:

Score Page Size = A4 (20.9991 x 29.70389)
x

Select an Ensemble: Select a Document Style:

Create New Enssmble Engraved Style Engraved Style (Maestro Fort)

Handwritten Style .

Gamtan SATE + Piano Band Finale’s all-purpose document style
Garmitan String Quartet Choral . ;

Garmitan Brass Guintet General Title, Subtitle, Compo_ser, Amanger,
Gamtan Woodwind Quirtst Orchestral _S::cre;'F‘art. and Copyright test
Gamitan String Orchestra inserts

Gamtan Small Concert Band

VD Lite Batteny Percussion —

WDLite Marching Percussion

SATB+Piano

Brass Trio Llwans Uee Thiz Macument

Brass Quintet Shyle with the Selected

Brass Choir id| Ersemble

Delete |

Score Page Size: |Letter (21.59x 27.94) |

Letter (21,59 27.94)
Legal (21.59x 35.56)
Part Page Sige: | 1201019 (27.94x 43.18)

it Fage Size: | 4r (14 79803 ¢ 20.99028)
B5 (17.58597 x
A (20 9997 x 2
B4 (2575278 x 36.39735)

A3 (29.6B625x 41.98937) : - :
Statement (13.97x 21.59) < Dporwnuuevo| Endpzvo > I Arupo
Hymn (14.605 x 20.955)

Part Page Size = A4 (20.9991 x 29.70389)
5I

Select an Ensemble: Select 3 Document Style:

Create New Ensemble Engraved Style Engraved Style (Maestro Font)

Handwritten Style .

Gamitan SATE + Piano Band Finale's allpurpose document style
Gamitan String Quartet Charal . )

Gamitan Brass Cuintet General Title, Subtitle, Cnmpo_ser. Amanger,
Gamitan Woodwind Cuintst Orchestral Scorez‘Part. and Copyright text
Gamitan String Orchestra inserts

Garmitan Small Concert Band

WDLite Battery Percussion —

WD Lite Marching Percussion

SATE+Fiano

Brass Trio Always Use This Document

Brass Guintet Shyle with the Selected

Brass Choir x| Enzemble

Lelete |

Score Page Size: [Ad (20.3991x29.7038%) x|
{* Porat ¢ Landscape

Patt Page Size: | Letter (21 59x 27.94) |

Letter (2159 27.94)
Legal (21.59x 35.56)
Tabloid (27.94x 43.18)

A5 (14.79903 x 20.99028)
|B5 (17.58597 x 24 99431) | <ﬂ|:unr1'fnl.'luevu:|| Endpsvo = I Arupo




To napdBupo Twpa gaiveral £T0l:

Document Setup Wizard - Select an Ensemble and Document Style ﬂ

Select an Ensemble: Select a Document Style:

Create New Ensemble Engraved Style Engraved Style (Maestro Fort)

Handwritten Style .

Gamtan SATE + Piano Band Finale’s all-purpose document style
Gamitan String Quartet Choral . _

(Gamtan Brass Quintet Generl Title, Subtitle, Campa_ser, Amanger,
Gamtan Woodwind GQuintet Orchestral _ScarefF‘art. and Copyright text
(Gamtan String Orchestra inserts

Gamitan Small Concert Band

WD Lite Battery Percussion —

WDLite Marching Percussion

SATB+Fiano

Brass Trio Alwavs Hze This Documett

Brass Cuintet Stulewith the Selected

Brass Choir | Enzemble

Delete |

Score Page Size: [A4 (209991x29.70389) 7]
{* Porrsit ¢ Landscape

Part Page Size:  |A4 (20.9991x29.70389) =]
{* Portrat { Landscape

< MNponyoupeyo Aropo
KAlk oto ENOHEVO
EugavileTal To 2° napddupo diapopPpwong:
Document Setup Wizard - Add or Delete Instrument(s) ﬂ

Instrument Set: ISmartMusic Sioft Synith j

Keyboards

Chorus Piano [No Staff Mame]

Woodwinds Crgan

Brass Harpsichord

Strings Celesta A

Plucked Strings Accordion

Fretted Instruments Clavichord ¢ Bemove | =
Pitched Percussion Harmanium —

Percussion Synthesizer Jhd |
Drums Theremin

Marching Percussion Ondes Martenot Sdd Yertical

Handbells Space »

Orff Instruments

Empty Staves

¥ Use a separate channel for each staff Score Order: Igmhestﬁﬂ j

¥ Generate Linked Parts

Enzemble
Eruer:;ﬁ::el?nb;:nble Sawve Curent Ensemtle | Save as New Ensemble... |
<Dpcrwol_'|u£m| Endpevo > | Aropo |

EmAgyeic (av dev eival emAeyueva) Keyboards <« Piano

KAk oto Add (evaAAakTika: 8inAd kAik oto Piano)




>Tn ouvéxeld, NpooBETeIC To BIOAI emAgyovTac Strings « Violin [single]

KAk oto Add (evaAAakTika: dinAo kAik oto Violin [single])

Document Setup Wizard - Add or Delete Instrument(s) x|

Instrument Set: ISmartMusic St Synith

Keyboards Violin [single

Chorus Viola [single]

Woodwinds Cello [single]

Brass Bass [zingle]

Violin

Plucked Strings Wialin |

Fretted Instruments Wialin 11 < Remove =

Pitched Percussion Viola -

Percussion Cello jhd |

Drums Violoncello

Marching Percussion Contrabass Add Vertical |

Handbells Double Bass |- Spac_e ;CE

Orff Instruments Solo Violin

Empty Staves Solo Viola

Solo Cello x|
¥ Use a separate channel for each staff Score Order: IOrchestlaI j
¥ Genemte Linked Parts
Enzemble
Cument Ensemble:

|7 Create New Ensemble Save Cument Ensemble | Save as Mew Ensemble. .. |

<Dpcrwol_'luﬁml Endpevo = Aropo |

To BIoAi npEnel va ypa®Tei navw anod To niavo.
Ma va To YETAKIVAOEIC OTN owaoTr B£0n, ENIAEYEIC
Strings = Violin [single] = Violin [single]

Kal KAVEIC KAIK 0TO nave BeAAKI nou BpiokeTal oTo apioTepd NEPOC TOU napabupou.

Document Setup Wizard - Add or Delete Instrument(s) x|

Instrument Set: ISmartMusic Saft Synth

Keyboards Violin [single Piano
Chorus Viola [single] — hmmg_
Woodwinds Cello [single]

Brass Bass [single]

Strings Wiolin Add =

Plucked Strings Wialin |

Fretted Instruments Wialin 11 < Remove B
Pitched Percussion Viola -

Percussion Cello jhd |
Drums Yioloncello

Marching Percussion Contrabass Add Vertical |

Handbells Double Bass | Spac_e :}lca

Orff Instruments Solo Violin

Empty Staves Solo Viola

Solo Cello |

¥ Use a separate channel for each staff Score Order: IOrchestlaI j
¥ Generate Linked Parts

Enzemble
|7 Erue?;tr'l.lz::el?nt::nble Sawe Curent Enzemble | Save as New Ensemble. . |

<Dpor]1,ml_'|u£m| Enopsvo = Aropo |




-6-

Twpa Ta opyava €xouv Tn owoTn dIaTaén:
Document Setup Wizard - Add or Delete Instrument(s) x|

Instrument Set: ISmartMusic Soft Synith

Keyboards | single

Chorus Viola [single]

Woodwinds Cello [single]

Brass Bass [zingle]
Violin Add >

Plucked Strings Wialin |

Fretted Instruments Wialin 11 < Remove =
Pitched Percussion Viola —

Percussion Cello hd|
Drums Yicloncello

Marching Percussion Contrabass Add Verical

Handbells Double Bass — Space ::ICEI |

Orff Instruments Sala Violin

Empty Staves Solo Viola

%o!u (_:ellu LI
¥ Use a separate channel for each staff Score Order: ICustnm j
¥ Genemate Linked Parts
Enzemble
Eruer:;ﬁ::el?nb;:nble Sawve Curent Ensemtle | Save as New Ensemble... |
<Dpcrwol_'|u£m| Endpevo > Aropo |
KAlk oto ENOHEVO
Document Setup Wizard - Add or Delete Instrument(s) ﬂ

Instrument Set: ISmartMusic Soft Synith

Keyboards Violin [single Vialin [single
Chorus Viola [single] — Piana
Woodwinds Cello [single]
Brass Bass [zingle]
Violin Add >
Plucked Strings Wialin |
Fretted Instruments Wialin 11 < Remove =
Pitched Percussion Viola —
Percussion Cello hd|
Drums Yicloncello
Marching Percussion Contrabass Add Verical
Handbells Double Bass — Space ::ICEI |
Orff Instruments Sala Violin
Empty Staves Solo Viola
%o!u (_:ellu LI

¥ Use a separate channel for each staff Score Order: ICustnm j
¥ Genemte Linked Parts

Enzemble

Eruer:;ﬁ::el?nb;:nble Sawve Curent Ensemtle | Save as New Ensemble... |

Aropo |

< Dponvo'-"uzvo|
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Eugaviletal To 3° napabupo diapdppwong:

x
Title: I
Subtitle: :I
[~
Composer: ;I
=
Amanger: ;I
=
Lyricist: |
=
Copyright: |2 ;I
[~
<Dpcrwol_'|u£m| Endpevo > Aropo |

SupnAnpwvelc (av B€Aeig, dev eival anapaitnTo) Ta diagopa nedia.

Xpnoigonoinoe AATIVIKOUC XapakTAPEC yia OAa, o’auTtn Tn ¢Aacn To Npoypapua moeavov
va pnv avayvwpilel akopn Ta eAAnvika. Av oou Eepuyel kanoio AaBog, unv avnouxeic,
Ba 1o dlopOwooupe apyoTepQa.

>T0 Arranger ypawe 1o Ovoud oou (0a pe BonBnoeic apyoTepa va EEPw OE NoIoV
avnkel n kabe aoknon nou 6a diopbwvw.

x

Tile: [SONATE No 12
Subtitle: fur Pianoforte und Violine ;I
Compaoser: [von :I

W, A MOZART. LI
Amanger:  |I0E ME AENE] ]
Lyricist: A |
Copyright: |S MA MH ZE MOIAZEI ;l

4 Dpur]%,ml.’luﬂml Endpsvo > Arupo




-8-
KAlk oto ENOHEVO

Eugaviletal To 4° napabupo diapdppwong:

x
—Select a Time Signature ———————— 1 Specify Initial Tempo Marking
g C ﬁ Text: I
g g g - Tempo: 3 ) | = [iz0
rSelect a Concert Key Signature ———— T Specify Pickup Measure ———————————
A =]
4 _ ol o | J L8]0 &
r IMEJDI' Key x|
2 oo | L LA & A] &
C Major =]

MNumber of Measures: IE‘I

< Mporyodpsvo | Téhog I Hupo

EniAgyeic:
Select a Time Signature = 2/4
Select a Concert Key Signature = kAik pia popd oTo navw BeAdki

SupnAnpwvelg Ta nedia Text kai Tempo (ac noUpe 0TI To tempo cival: 4°=64)

x
—Select a Time Signature —I¥ Specify Initial Tempo Marking
3 e E g 3 f'| Teat: Iﬁndantepu:ucu:u Adagio
JHHGE R
—Select a Concert Key Signature ————————— 1 Specify Pickup Measure
n s s
y —_ Jll'ﬂl{E)'J ununmﬁﬁﬁﬁ
[ an] 3jar e
Y i o[ L LB & &
® G Major .| 4]

Mumber of Measures: |3‘I

< Mponyolpsvo Aropo

KAk oTo TEAOG
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Ep@aviCeTal n diapoppwpevn oeAida. Ta textblocks pnopei va unv €ival otn 8€on Toug,
Ba Ta TaXTONMOINOOUKE apyoTeEPA, OTNV TEAIKN Hopgornoinon TnG oeAidac. AAAwaoTE, av
BEAe€IC n 0gAida va €ival navopoloTunn YE Tn OOOHEVN, NPENEl va NPOOOECEIC JEPIKA Kal
va aQaipeoeIC kKanola aAAa. ApyoTepa...

EmAgyeic Save (Onwc kal Kabe popd nou oAOKANPWVEIC KATI). AG MoUPE OTI ovopaleig
To apxeio «sonate». Ekei nou Ba To owoelig npenel va sp@avifeTal we sonate.mus
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Twpa JNopeic va apxiosic va ypAagpeic VOTEC.

Evyw, 6Tav ypapw VvOTEC, NpoTIH®W va BAENW TNV NapTiToupa pou os Scroll View.
duoika pnopeic va doUAEWeIC kal os Pege View.

Ma va aAAG&eic avapeoa oTIG TPEIG ENIAOYEG ENPAVIONG EMIAEYEIC

View - Scroll View

n

View - Page View
n

View - Studio View

Ano To View pnopeig kal va kaveig Zoom in p Zoom out
(evaAAakTika pe Ta nANnkTpa [Ctrl]+[+] kai [Ctrl]+[-] avTioTOIXA.

>uveyilw oe Scroll View:
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Ma va €ival capeoTeEPEG 0l NAPOUTEC ONUEIWOEIC EXW ANOPAKPUVElI anod To napabupo
Hou o6oa dev xpelalopal aueoa. EmAgyeic Window kal apnveic emAeyheva povo 1o Main
Tool Palette (kevTpikoc nikavakag epyaAsinv) 1o Status Bar (oou gugavilel 0To KATW
HMEPOC TNG 000VNG To OVOUA TOU EPYAAEIOU NMOU EXEIC KADE popa ENIAEYHEVO KAl HEPIKEC
NANPOPOPIEC YIa TO O€ Ti XPNOIKEUEI) KAl TO OVOUA TOU dpxXeiou nou douAeguelC (edw TO
EXOUME nel «sonate»).

Mnopeic va €I0AyeIC TIC VOTEC UE TPEIG TPOMOUG: d) YE TO NOVTIKI, B) ano To
NANKTPOAOYIO, Y) HE OUVOUAONO Tou NMANKTpoAoyiou kal evoc midi keyboard.
(GewpnTikd pnopeic kal va TI¢ nai&eic os real time aAAd Ta anoTeAéopara sivai
anoyonTeuTIKA...).

©a avTiypdWOUHE TO NMPWTO METPO Tou BIoAIOU Kal Tou JeEloU XepIoU Ye dUO TPOMOUG:

a) ME TO NOVTIKI

MNa va ypaweig voTeg HEe: sniAeyelg Tnv a&ia, Tnv aAAoiwon, Tn oTi&n KAN, KAl KAVEIG
KAIK €kei Mou BEA&IC va ypaTei.

MNa va ypaweig anA&gg ouvnXnoeig (OAEG 01 VOTEG HE Evd HNACTOUVAKI): YPAPEIC
Mia voTa kal cUPNANPWVEIC TIG UNOAOINEG KAVOVTAg KAVEIG KAIK Navw N KATw an’
auTnv.

=ekIvAG PJE TO PEPOG TOU PBIOAIOU.
Anod To Main Tool Palette sniAgyeic To koupni Simple Entry Tool (oTnv €ikdva To
TEAPTO APIOTEPQA).
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To Simple Entry Tool sp@avileTal w¢ autovoun naiéra (av B€Aeig, To TpaBacg Pe To

NMOVTIKI KAl TO HETATPENEIC 0 deuTEPUOV NApabupo, pnopeic va aAAd&eic kal To oxnua
TOU)

>710 Simple Entry Tool sniAgyeic Tnv aia Tng voTag nou BEAeIC va ypayelg (ag nouue
OTI 6a ypAWEIG NpwTa To 21 KAl JETA TO Pg), €dw MICO.

Mnyaiveic To BeEAAK! 0TO NEVTAYPANHO EKEI NOU BEAEIC va ypapTEI AUTO TO MICO, £dW
oTo 21 (To YIoo6-21 paiveTal axva oav okia):

Kaveig kAik kal n voTa eival €Toiun.
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Ma va ypdaweic kal To Mi nou ouvnxei Je To 21, Xwpic va aAAd&eic Tinota and 60a €XEIC
NoN €NIAEEEl, Nnyaivelc To BeAAkl oTn B€on nou BEAeIC va ypaPTei, €dw otnv 1" ypappn
Tou 5ypdappou kal akpiBwe kKatw ano To Zi. To Mi axvogaiveTar:

Kaveig kAIk kal To M1 gg@avileTal kavovika otn 8€on Tou.
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JEIpA £XElI TO APIOTEPO XEPI OTO MIAVO.
>10 Siple Entry Palette cniAcyeic:
a&ia 16°Y kal atolakaroupa (oTnv eikova: 4° koupni d0g€i1d kal TeAsuTaio de&ia
avTioToixa)

Kaveig kAik oTo ®a kal JeTa oto Ad. Mnopei va pn @aivovTtal otn owaoTn 8€on, 6a
d10pOwBoUV auTopaTta (apyoTepa Ba doupe Nwc d1opOWVOUE Kal XEIpoKivnTa)
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>Tn ouvéxela oto Siple Entry Palette sniAgyeic:
a&ia 4°" kal ouleu&n diapkeiag (otnv sikova: 3° koupni Oe€1a kal NnpoTeAeuTaio de€id

avTioToixa).
KAIK 0TO ZOA.

EniAéyeic 16° kal anocmAéyeic (EekAIKApPEIC...) TN oUleuEn. KAIkdpeic To 16° oA

KAikapeig 32° kal dieon (5° koupni de€ia kar 7° d€€1a avrioToixa). KAk oto NTO digon
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=ekAIKApEIC TN dieon Kal, YE KAIKapIOWEVO To 32°, ypdgeIc To Ps

KAIK oTnVv avaipeon kai, Je navra eniAeypevo 1o 32° ypageic To NTo avaipeon
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=ekAIKAPEIC TNV avaipeon Kal ypda@eig Ta unoioina 32° (Zi-Aa-ZoA)

O1 vOTEG TOUu 1°Y pETpou Tou BIoAIoU kal Tou aploTepoU XepioU ival ETOINEG (ONH.: N
oUleu&n Npoowdiac ypagpeTal diapopeTika ano Tn oUleu&n diapkeiac, BA. NapakdaTw)

Ma va oBnosIc VOTEG I va PETATPEWEIC VOTEC 0 NAUCEIC ENIAEYEIC T YOpoAdoTixa (1°
Koupni 0€&1a) kal KAIKAPEIG TN vOTa.
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B) HE TO NNKTPOAOYIO
MPEMEI NA EINAI MONIMA NMATHMENO TO MNAHKTPO [Caps Lock] KAI NA EINAI

Kdanola ano Ta ypauuaTta Tou NANKTPoAoyiou avTioTolxouv o€ Tovika uyn:
XaunAn oktaBa: [Z]-NTo, [X]-Pg, [C]-MiI, [V]-®a, [B]-Z0A, [N]-Aa, [M]-ZI
Meoaia oktapa: [A]-NT1o, [S]-Pg, [D]-Mi, [F]-®a, [G]-Z0A, [H]-Aaq, [I]-Z
WnAn oktdBa: [Q]-NTo, [W]-Pg, [E]-Mi, [R]-®a, [T]-Z0A, [Y]-Aa, [U]-ZI

To nANkTpo [I] HETAPEPEI OAA TA NAPANAVW HIA OKTABA XapnAwTepa anod Tnv apxikn
avTioToiXIoN

To nANKTPO [, (KOMMa)] HeTaPEPEl OAA Ta napandvw Hia oKTapa wnAdTepa anod Tnv
apxIkn avTioToixion

To nANkTpo[K] enava@Epel oTo NANKTPOAOYIO TNV ApXIKN avTioToixion (@’ 0oov EXEl
NPONYOUMEVWC YiVEl HETAPOPA NAVW N KATW

Kanolol apiOpoi Tou nAnKTpoAoyiou avTigToixouv oTIC a&iec:
[1]-128°,[2]-64°,[3]-16° [4]-8° [5]-4°, [6]-H100, [7]-0AOKANpPO, [8]-OINAOG OAOKANPO

'OAec ol a&iec (nou €xoupe NON NANKTPOAOYNOEI) YivovTdl NAPECTIYHEVEC NnaTWVTAC (UE
TOV KEPOTOPA NMAVW TOUG I META an’ auTeg) To NARKTpPo [. (TeEAEia)].

To nANKTPo [+] o€Uvel pia ypapuevn vOTa KATd £va nUITovio (00EC (POPEC TO NATATEIC
TOOAQ NUITOVIA WNAWVEI).

To nANKTpo [-] Bapuvel pia ypaupevn voTa KaTa €va nUITOVIO NUITOVIO (O0EC POPEC TO
NATAOEIG TOOA NUITOVIA XAMNAWVEL).

To nAnkTpo [Enter] npooBeTel vOTEC O€ YiIa ouvnxnon.

To nARKTpo [=] avTioToiXel oTn oUleu&n Npoowdiac

(@)

T
T

nANkTpo [*] kpUBel N pavepwvel TNV aAAoiwon piag voTag.
nANKTPo [9] aAAalel Tig vOTEG evapuovia.

o O

T
T

nANkTpo [/] opadonoiei yeiTovika 8%, 16% kAn, kal To avTiBeTo.
nANkTpo [L] aAAdalel Tn gopd Tou pnacTouvioU Wiag voTag f piag opadac ano VOTEC.

o O

To nANKTPO [; (EAANVIKO EPpWTNHATIKO — ayyAIkO semicolon) psraTpenel pe
d1adoxIka naTAuarTa pia voTa o€ yikpn anotdiatoupa kai diaypaupevn atoliakartoupa.
Me TO TPiTO NATNHA TOU NMAAKTPOU N vOTa &avanaipvel To apxiko TnG YEyeBoC.

(@)
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MNepioodTepa schortcuts €dw:
http://www.finalemusic.com/UserManuals/Finale2012Win/Content/Finale/Keyboard S
hortcuts and Special Mouse Clicks.htm#HT Speedy Entry Tool

Nape va ypawoupe Twpa (av kanoiog €€0ikiwOei ye To NANKTPOAOYIO, MOAU oUvToua d€
XpelaleTal va KoITAgl TOUG Nivakeg avTioToixiong)!

>71o Main Tool Palette cniAéyeic To Speedy Entry Tool (oTnv sikova: 4° koupni
oe&la)


http://www.finalemusic.com/UserManuals/Finale2012Win/Content/Finale/Keyboard_Shortcuts_and_Special_Mouse_Clicks.htm#HT_Speedy_Entry_Tool
http://www.finalemusic.com/UserManuals/Finale2012Win/Content/Finale/Keyboard_Shortcuts_and_Special_Mouse_Clicks.htm#HT_Speedy_Entry_Tool
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Me TO NOVTIKI KAVEIG KAIK OTO HETPO Nou BEAEIC va YPAWEIG.
Edw oTo npwTo PETPO TOU BIoAlou. EpgavileTal evac kEpoopac (N KABeTN ypauun Yeoa
OTO KOUTAKI Nou QAiveTal va nepIBAAEl TO METPO, WE HIa HIKPH €vTovn opilovTia
ypapun). Me Ta nANKTpa-ReAAKia i JE To NOVTIKI METAKIVEIC TOV KEpoopa opilovTia Kal

KaBeTa.

MaTtdac 1o nANkTpo [J] yia va ndasl o kEpoopacg oTn B€on Tou 21 (UNOPEIC KAl va Tov
0dNYNOEIC EKEI JE Ta NANKTPA-BeAAKIa).
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'OTav 0 KEPoOPAG €ival oTn owoTh B€on NnAnkTpoAoyeic Tnv agia.
Edw: natdac 1o nAnkTpo [6].

To 21 eival oTn B€on Tou. Odnyeic Tov KEpoopa, YE Ta BeAdakia (f PE TO NMOVTIKI) OTN
B€on nou npenel va npooTelei TO Pe.



22
MNaTtac Eava 1o [6]

H ouvnxnon Pe-ZI €ival €Toiun. Me Tov id10 TpOMNO PNOPEIG va YPAWEIG OAEG TIC ANAEG
ouvnxnoeic (OAeG ol VOTEC JE €va UNACTOUVAKI).

Kaveic kAIk oTo 1° yETpo Tou aploTepoU XepioU. EvepyonolsiTal To HETPO Yid va
MMOPECEIC va YPAYEIC JETA TOU.
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MaTtac [F] yia va nasi o kEpoopac otn B€on Tou da.

MNatag [3] yia va ypaeTei To Pa-16°
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MNaTtdc [;] pia popad yia va yivel n voTa pikpn anotdiatoupa

MNatacg [H] kai peta [3] yia va ypapTei To AA-16°

MNaTtdc [;] yia va yivel n voTa pikpr anotdiatoupa
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Av o1 dU0 PIKpEC vOTEC dev £xouv opadonoinBsi auTopaTa, odnyeic Tov KEpoopa HETA
To Aa (ekei nou Aoyika Ba BpiokeTal HeETA TNV NANKTPOAOYnon Tou Aa) kai natag [/]

Av ol voTeC Og paivovTal owoTd 8a diopbwBouv autopaTta ) Ba Tic diopBwooupe
napakaTw.

MNaTtacg [G] yia To Tovikd Uwocg kal [5] yia Tnv afia, yia va ypaweic Tn voTa ZoA-4°
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MNaTtac [=] yia va ypayeig Tn ouleu&n diapkeiac (Je To id10 MAAKTPO WUMNOPEIC KAl va TNV
aQalpECEIC).

MNaTacg [3] yia Tnv a&ia (To Tovikd Uywog npolndpxel) yia va ypawelig To ZoA-16°
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MNatac [,] yia va aveBaocsic To NANKTPOAOYIO Hia okTABa Kal va YNopECEIC va YPAYEIC
To YnAO NTo (aAAIWG: dev NATdag TinoTa Kal odnyeic Tov KEpoopa Pe Ta BeAdkia)
MNaTtacg [Q] yia To Tovikd Uwoc (kavovika avTioToixei oto NTo Tou 3°Y diaoTrpaTog,
aAAd €@’ 00OV EXEIC NPONYOUNEVWC naTnoel To [,], o kEpoopac 6a nasi oto NTO nou
BeAeig va ypdweig), natag [2] yia Tnv a&ia yia va ypdaweig To NT1o-32°,

Kal auéowc PJeTa natac [+] yia va o&uveic To NTo-32° oe NTo#-32°
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MaTtag [W] yia 1o Tovikd Uwog kai [2] yia Tnv a&ia yia va ypdyeig 1o Pe-32°

MaTtag [Q] yia To Toviko Uwog kal [2] yia Tnv a&ia yia va ypawelg To NTo (0nwg
BAENEIC N avaipeon ypAPTNKE auToOUATA).
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MNaTtac [K] yia va enava@epeic To NANKTPOAOYIo (va avaipeoeIc TNV NponyoUudEevn
HMETAPOPAG Nou €ixel yivel ye To narnua Tou [,]).
MNatacg [U] kai [2] yia To 21-32°

[Y] kai [2] yia To Aa-32°

[T] ka1 [2] yia TO Z0A-32°

Kaveig kAIk €Ew ano 1o PETPo (1 natac To nAnkTpo [0]) yia va dsic To HETPO. AoyiKa Ol
VOTEC BpiokovTal TN OwOoTH TOuG BEon.
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A@OoU TEAEIWOEIC PE TIC VOTEC (aveEapTnTa nola HeBodo XpNOIKOMNOINCEC yia va TIC
ypAWeIC), Unopeic va BaAeic kai Tic duo ouleu&eic npoowdiac (npoTeivw o1 ouleU&eic va
gnaivouv YeTa and Ta cUPBoAa apBpwonc, €dw OPwC dev TiBeTal Bepa).

>71o Main Tool Palette cniAgyeic 1o Slur Tool (oTnVv sikova: 6° koupni de&ia) kal
eppaviletal To Smart Shape Tool (oTnv sikova: To 0ei deuTepelov Napabupo HE Ta
MMAE KoUupMa).

>71o Smart Shape Tool sniAéyeic To Koupni pe TN Aeykatoupa (oTnv €ikova: 1° koupni
0e€la — oTtnv d€&Id naAéTa...).

Kaveig dInAG KAIk oTo HIkpO ®a (To PIkpd da npénel va oKIaoTel KAl va NgavioTel ano
KATW auTn N KOKKIVN YPAWUN)KAl KpATAG KPATNHEVO TO NMANKTPO TOU MOVTIKIOU.
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Me natnuévo (anod npiv) To NANKTPO TOU, OEPVEIC TO MOVTIKI HEXPI VA OKIAOTEI N vOTa
oTnVv onoia B€A&IC va kaTaAlAn&el n AeykaToUpa, €dw TO Z0A-4°

AQ@nVeIc ToO NANKTPO TOU NOVTIKIOU Kal N AeykaTtoupa npenel va €ival otn owaoTn B€aon.
O1 HIKpoi pOuBOI 0Ta AKpa KAl TO HECO TNG XPNOIKEUOUV YIA VA TPOMONOINCEIC TO JWAKOG
Kal TNV KAUNUAOTNTA TNG, O NMEPINTWON NOouU undpxel Kanolo YNeEPdEPa Pe aAAa
oUpBoAa. Edw dev npénel va xpelaoTei Tinota and autd.
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Opoiwg, Kavelg dINAO KAIK oTo NTo#-32° YEXpPI va OKIAOTEI,

OEPVEIC TO MOVTIKI JEXPI VA OKIAOTEI KAl TO Z0A-32°

aneAeUBEPWVEIC TO MOVTIKI.
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H Aeykatoupa npenel, Aoyikd, va BpiokKeTal oTn owoTn B€on

AZKHzH:

EqpapHOoOE 600000Ad TA NAPANAV®, AVTIYPpAPoOvVTac ano Tn S0oHEvn oeAida
OAo TO HEPOG TOU BIOAIOU.

KAAH AIAZKEAAZH...!
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>TO NPWTO PETPO-OeEi XEPI BEAOUNE va Xwpiooupe Ta €€ 32° o dUO opadeg (Hia Twyv 2
Kal hia Twv 4). MNp€nsl va «onacoupe» Tn ypauun Tou 32°%° aAAd ol unoAoineg (Twv
16“Y) va peivouv oTn B€on TOUC.

Edw 6a xpeiacTtoupe Ta Advanced Tools:

Av n napanavw NaA&TTa 0ev €XEl AUPAVIOTEI AUTOUATA, AVOIYOUME TN Awpida
Windows ki eniAéyoupe To Advanced Tools.



-35-
>Tnv naAétta Advanced Tools sniAéyoupe To Special Tools (1° apioTepd-opupdki)

Ep@aviCetal n Special Tools Palette,
oTnV onoia eniAéyoupe To kouuni Beam Brake Tool:

Kavoupe KAIK 0TO PJETPO Nou BEAOUPE Kal egpavidovTal TETpAywvdakia navw ano TIG
VOTEC NOU PNOPOUKE va ENEPPOUPE
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Kavoupe dINnAO KAIK OTO TETPAYWVAKI TNG VOTAC an’ Tnv onoia &EEkIvAasl To Xwpioua

eppaviletal To Secondary Beam Break Selection

Secondary Beam Break Selection x|

& Break through
" Break only

Bearmn Durations
[T 16th [ 128th [~ 1024th
[T 32nd [ 256th [ 2048th Reset

[T eath [ si2th [ 4096th

Cancel

Help

oTo onoio emAg&youpe To 32° (Tnv a&ia nou BEAOUHE va XWPICOUWE)
x

{* Break through
" Break only QK

Bearn Durations
[~ 15th [ 128th ¥ 1024th

¥ Zand ¥ 256th ¥ 2048th Reset

¥ g4th [ 512th W 4096th

Cancel

Help




MNaTtaue OK. 'ETolpo!
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>70 O€&i Tou niavou (1° PETPO) NpEnel va ypaywoupue 3nxa.

a)Me 1o novrTikI:
EmAgyoupe To Simple Entry Tool:

>TNV NaAETTa Pe TIC a&iec emAéyoupe Tnv afia pacg (16°) kal To €1kovidio PJeE To 3nXO:



MANKTPOAOYOUHE WE TO NOVTIKI TIC VOTEC
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B) M& To NANKTPOAOYIO:

EmAgyoupe To Speedy Entry Tool

Mnaivoupe 0TO YETPO NMou BEAOUME va YPAWOULE.

MNatdape padi [Control]+[povada 3nxou], v npokeipevw [Control]+[3]. Navw
0€&1G OTO TETPAYWVO Nou nepBAAel To HETPO eupavileTal €va Pikpo 3. AuTO onuaivel
OTI ol VOTEC nou Ba nAnkTpoAoynooupe Ba eival 3nxa (av eixape natnoel [control]+[6]
Ba suavifoTav eva 6 kal 6a ypa@ape 6nxa Kok).
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H npwTn a&ia nou 8a nANKTPOAOYNOOUWE €ival n Jovada Tou 3nxou. Edw nAnKTpoAoyw
[3] (16°) kal ypapw TIC VOTEC HOU
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>naw Ta 3nxa ava 3 (Je Tn pEBodo nou neplypdPnke napanavw)
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Ta 3apia Twv dU0 NPpWTWV 3NXWV MPENEl va NAve NAvw ano TIC VOTEC. TwV UnoAoInwyv
npenel va eEagavioTouyv.

EniAéyoupe To Tupplet Tool

Kavoupe KAIK 0TnNV NpwTn VOTA TOU 3nX0U KI eupavileTal Eva TETPAywvdakli



-45-
Me To NovTikl oEpvw Ta 3apia oTn B€on nou BEAw va gpgavilovrai.
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EmAg&yw To TpiTo 3nX0 (Nou BEAw va kpUWw To 3apl Tou), Kavw dINAO KAIK OTO
TETPAYWVAKI TOU KI EgpavideTal To napabupo eneEepyaciac Tou 3nxou

]
[3 [16the) =] nthespaceof: [2  [1sth(s) |

~Placement——————— ] [ Appearance
IStem,."Eieam Side j Mumber: INumber j
¥ Engraver tuplets Shape: IBran:k.Et j
W Avoid staff W Break slur or bracket
[~ Allow horizontal drag " Always use spedified shape
[~ Use bottom note {” Bracket unbeamed notes only
¥ Never bracket beamed notes on beam side

 Position
Horizontal Vertical
Tuplet: ID 0.21167 Left Hook: ID. 10533
[T center number using duration

Right Hook: I 0.10583
[™ Ignore Horizontal Mumber Offset
Shape: I a ) Left Extension: I 0
I Always flat Right Extensign: |0

[~ Bracket full duration

Manual Slope
¥ Match length of hooks Adjustment: I 0
Cancel Set Default | Reset | Help |

Kavw TIC anapaitnTeg emAoyec kal nataw OK



Tuplet Definition x|
I 3 |16H1{s}l 'I In the Space Of; I 2 |16ﬂ1{5) Yl
—Placement——————————— [ Appearance

IStemeeam Side 'I Number: INoﬂwing 'I
[ Engraver tuplets 0
¥ Avoid staff
[ allow horizontal drag
[ Use battommnote " Bracket unbeamed notes only
% Never bracket beamed notes on beam side
r~ Position
Horizontal Vertical
Tuplet: I o] I 0.21167 Left Hook: I 0.10583
[~ Center number using duration
o ight Hook: I 0.10583
I™ Ignore Horizontal Number Offset fa
Shape: Ig Ig Left Extension: ID
I Always fat Right Extension: [0
[~ Bracket full duration Manual Slope
¥ Match length of hooks Adjustment: I 0
0K I Cancel | Set Default | Reset | Help |
x

[3 [isthes) -
rPlacement——————
IStem,.’Beam Side 'I
¥ Engraver tuplets

v Avoid staff

[~ Allow horizontal drag

™ Use bottom note

Inthe Space Of: [2 [15th(s) -]

[~ Appearance

Number: INoihing hd l
Shape: INoﬁwing - I

Nothing
" AlwaydBracket

" Bracket unbeamed notes only

% Never bracket beamed notes on beam side

r~Position
Horizontal

[~ center number

Vertical

Tuplet: |u | 0.21167

Left Hook: I 0.10583
ing durati
Lol Right Hook: I 0.10583

™ Ignore Horizontal Number Offset

Left Extension: ID

Shape: I[.’l I[J
[ always flat Right Extension: ID—
[~ Bracket full duration e
¥ Match length of hooks Adjustment: I 0
OK I Cancel Set Default | Reset | Help |
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EnavaAauBavw Tnv idia diadikaoia oTo TETAPTO 3NXO

‘ETOIMO!
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And To napabupo eneEepyaoiac Tou 3nNXouU, JE avaloyeg ENIAOYEC, UNOopw va dwow OTa
Tupplets diapopec pHOpPEC:
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>Tn ouvéxela 8a BaAoupe To onueio TNG enavaAnync:

EmAgyoupe To Repeat Tool

Kavoupe dINAO KAIK OTO JETPO NOU BEAOUME KI AVOIYEl TO MAPAKATW:
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EMNIAEYOUNE TNV enavainyn rnou BEAoupe kal nataue Select.

Avoiyel To napakatw napdadupo. Matdape OK

Baclward Repeat Bar Assignment, Measure 4 il
—Repeat Action
' Play section: I 2 times
™ Jump on pass: I 1

r Res=et on repeat action

" Always jump

Target: INearest Forward Repeat j I

Show On
€ 4l staves

£ Top staff only

! Staff list: | | Edt. |

™ allow individualedits per skaff for ending bracket

Cancel Help

H enavaAnyn ival €Toiun
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3TN OUVEXEIQ KAVOUHE JINMAO KAIK OTO EMNOMEVO HETPO

Kal oTo NapdBupo nou avoiyel, ENIAEYOUHE TNV KATAAANAN enavaiAnyn



Graphic Repeats:

_I‘I_
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Repeat Selection

Forward Badk

Text Repeats:

Badk Ending
Ending

D.C. al Fine
D.C. al Coda
D.S. al Fine

D.S. al Coda

To Coda#

Fine

2

P

Go To Measure #

(1)
(£)
(3)
(4)
(5)
(F)
(C)
()
(G)

il

Bl

Select

Cancel

Edit...

Create...

Duplicate

Deleke

Mowe g

Mowe Down

Help |

MNataue Select
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Me Ta YEXPI TWPA €iHacTE 0 B€0N va YpAWOUNE OAEC TIC VOTEC TNG OgAidac. Meavov
oTnv 00ovn Jag va gpaiveral Aiyo avw KaTtw ny.

Mpiv NPpOOOECOUNE Ta oNHEIa ApOpwonG, EKPopPac, SUVAHIKEG, AEyKATOUPEG
KAN. KaAo €ival va HoOpPONOINOOUHE TN OcAida HaG, WOTE va Ta TONOOETOUHE
Kal va Ta BAENOUHE oTnv 000vn Onwg 6a paivovTal Kal oTNV EKTUNWON.

2TO ENMOMENO MAGHMA...
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NMape va HopPONOINCOUHE TN OeAida pag
Znu.: EVVOEITAl Nw¢ Ol EVEPYEIC Nou akoAouBouv Oev €ival UNOXPEWTIKO va yivouv LIE
TN O€Ipd nou nepiypd@ovrai. Enionc or Tiuec nou Ba divouue ora napdbupa rou
akoAouBouv eival evOEIKTIKEC, KABe popd rnpéenel va 0oKIUAlOUUE yia va NMETUXOULE TO
KAAUTEPO Kal KOUWOTEPO dUVATO ANOTEAEOUA
MpwTa 8a opIKPUVOUHE Aiyo TIG vOTEG. Mia pEon TIMA avayvwong yia Ta gepn €ivar 85-
90% TwV opyavwy, yia TIC NapTITOUpPEC eEapTdTal ano To TI nepieExouv (nooa opyava,
nOCO MUKV €ival N JOUGCIKN KAM.)

EnmiAéyoups: Main Tool Palette > Resize Tool

>Tn Resize Page nou avoiyel cupnAnpwvoupe Resize Page To: 85%, Page 1
Through the End of Piece (evdexopevwc: All Pages), Hold Margins, Update
Pege Format.

x

Resize Page To: IEE % |V Hold Margins

—Page Range

Current Part or Score j Select, ., |
" Page: |1 Through: I |

* Page: |1 Through End of Piece

¥ Update Page Format

oK I Cancel Help

MNataue OK
H ogAida pac deixvel Kanwg €101
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Twpa 6a opikpUVOURE TO S5ypappo Tou BioAiou.

Me eniAeypevo navta 1o Resize Tool, kavoupe kAIk ndvw oTo S5ypappo aTtou BioAiou.
>710 Resize Staff nou avoiyel, cunpAnpwvoupe Resize Staff To: 65%, System 1
Through The End of Piece.
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Resize Staff x|
Resize Staff To: I 65 B

Staff System Range

" System: I 1 Through: I 1

" System: I 1 Through End of Fiece

K Cancel | Help

MNatape OK
H oeAida deixvel Kanwg £T01:

>Tn ouvéxela Ba d1opOWOOUNE TIC ANOOTACEIC avaueoa oTa 5ypapua.
>Tn Main Tool Palette sniAéyoupe 1o Staff Tool
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KavovTac kAik dinAa oto 5ypappo Tou de€lou XepIoU To eNIAEyYoUNE (MPOOoOXN Vva
enMAeyei o0AOKANPO)
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Me TO NMOVTIKI OEPVOUNE TO TETPAYWVAKI TOU NMPoC TA NAV®

MEXPI va nael oTn B€on nou BEAouUPE (va gnv HNAEKOVTAl Ol VOTEC TWV SYPAPP®V).

Kavoupe To idl0 Kal oTo 5ypaupo Tou apioTepou Xepiou.
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Twpa n napTiToupa OcixVvel KANWC £TOI:

Twpa O6a YETAKIVI)OOUHE Ta PETPA Nou dev BpiokovTal 0To owoTO cuoTnua (kaTtda To
npoTund pac).
Main Tool Palette>Selection Tool
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EmA&youpe kKGBe popd To PHETPO NMou BEAOUME VA PETAKIVIIOOUHPE OTO MPONYOUHEVO N
OTO ENOHEVO oUOTNHA, KAl TO HETAKIVOUME NATWVTAG TO NAVW N TO KATW BEAAKI Tou
nNANKTpoAoyiou pag:
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Twpa 6a popponoinooupe Tn oeAida pac.
Main Tool Palette->Page Layout Tool

Page Layout->Page Size
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>To Napabupo rnou avoiyel EMAEYOUUE
A4, Portrait, All Pages

x|

eI kL)) ~| [ Change

{* Portrait ICurrent Part or Score j Select, .. |

£ Landscape ™ Page: |1 only

Width: | 20.9991 * Al pages
Height: [ 23.70335 (" Left pages Right pages
i Page range:

From: I 1 Through: I
oK I Cancel | Help

OK n ocAida dcixvel T0I:
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KaAo €ival va opiow w¢ povada PETPNONG TO EKATOOTO (OUVABWC €ival NMPOEMIAEYHEVN
n ivroa).

Edit>Mesurement Units>Centimeters
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OpiCoupe Ta nepibwpia. Me eniAeyuevo navra to Page Layout Tool
Page Layout->Page Margins->Edit Page Margins

Avoiyel To napabupo Edit Page Margins.EniAcyoupe All Pages kal cUNNANpwWVOUUE
Topl.27-Leftl.27Rightl1.27-Bottom 1.27

Edit Page Margins |

Top ¥ | 1.27

left ¥ [127  |127 | ¥ Right

1,27 | Bottom

—Change
" Page: |1 " Al pages:
i~ Left only ™ Right only

i Pages: I 1 Thru: I

[T adjust [eFt ar right anly

Apply Apply to Parts/Score... | ﬂ i

Inataue Apply
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OpiCoupe TIC anooTaoelC avauyeoa oTa ouoThUaTa 5ypaupwy. Opifoupe Ta nepibwpia.
Me eniAeypevo navrta To Page Layout Tool
Page Layout->Systems—>Edit Margins

>T0o napabupo nou avoiyel emAgyoupe All, TopO-Left0-Right0-BottomO0, Space
Between Systems1.4

Edit System Margins £

Values for System: 77
Top V¥ |0

Left ¥ |0 |0 W Right
] v Bottom
[¥ Distance between systems: I 1.4

Change
{Sistem: I 1 Thru: I All |
For Page: 1
Sp-ace for Additional System: 0

Inatape Apply
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To npwTo oUOTNUA NpEenel va KaTeRel Aiyo yia va dwaoel Xwpo OToV TITAO Kal va
Eskivdsl ano Aiyo nio pJEoa yia va (paivovTal Kal Ta oVvOUaTd TwV opyavwy.

>T0 napdabupo Edit System Margins nou €xoupe NON avoi&el eNIAEYOUUE

System 1 Thru 1, Top-1.2, Left-2, Right-0, Bottom-0, Distance between
Systems 1.4

Edit System Margins |
Values for System: 77

Top v | 1,19944

Left ¥ |p.0o201 |o [V Right

| 0 v Bottom

[¥ Distance between systems: I 1.4

—Change
System: | 1 Thru: | 1 All |
Far F‘age:_l

Space for Additional System: 0
Apply I .ﬁ.pplytnParts,."SgurE...l :::| ?

nataue Apply



H oeAida €xel diapoppwoEi:
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Ma va YETaKIVNOow Ta NAdiola KEINEVOU OTN OYWOTN Toug BEon eMAEYw
Main Tool Palette>Text Tool

Kal JE To NovTikl oepvw €va eva Ta Text Blocks (ano 1o TeTpaywvaki Toug) otn 6€on
nou BéAw
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>Tnv napTitoupa rnou avTiypa@oupe Osv (paivovTal apiBuoi HETPWV.
Ma va Toug Kpuyw

Main Tool Palette->Mesure Tool

oTn ouvexeia Mesure->Edit Mesure Number Regions
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Mapdabupo nou avoiyel emAeyw Region->Delete> 0K

Measure Humber

Fegion 1, measure 1to 999 — Displs Delete
Add
Sort
Fegion: 1
Indudes Measure: 1_ Through: | 999 View In: I,a.ll Views |
Starting Mumber: 1_ Style: |1, 2 3, 4 j Prefix: I SgFﬁx:I

score | Linked Parts |

Show On: W Top Staff [ Exdude Other Staves
™ Bottom Staff

¥ Show measure numbers at start of staff system

™ Endosure: ISquarE j Edit... |

¥ Hide first measure number in region

Font: Times New Roman 10 italic setFont... | Position...
[~ Show on every: I 1 measures beginning with measure: I 1

[~ Endosure: ISquarE j Edit... |

[ Break Multimeasure Rests

Font: Times Mew Roman 10 italic ek Fort... | FOSILan...

[~ Show on multimeasure rests

[~ Show measure ranges on multimeasure rests  Range Bracket Left: I Right: I

Font: Times New Roman 10 italic Sk Font. ..

| Position. ..

Cancel | Help




O1 apiBuoi TWV HETPWV EQuUYAV
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MNa va ypaww Ta onuadia apbpwaong
Main Tool Palette~>Ariculation Tool

KAIK Navw oTn voTa nou BéAw va ypadyw To onuadi.
Avoiyel To Articulation Selection,cniAéyw To onuadl nou BEAW

x
3 4 ﬂ
v > T
i > -
7 8
A _
v v -
9 10 11 12
= '
b
_ i s
= &
13 14 15 16
i’; fg‘ e gy

A
Edit... | Duplicate | Delete | [ave Up | Move Down | ﬂ ﬂ
Create... | Select I Cancel | Help |

MaTtaw Select
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To onuadi ival otn B€on Tou.Ano To TETPAYWVAKI TOU PMNOPW VA TO HETAKIVAOW av
XPEIAOTEI.

EnavaAauBavw Tnv idia diadikacia yia kabe voTa nou xpeialerai.

MNa va ypaww Ta onueia Ekppaonc
Main Tool Palette>Expression Tool
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MNa va diopbwow (N kal va dnuioupynow) &va onuadi
AINAOG KAIK OTO TETPAYWVAKI TOU

Avoiyel To napabupo Expression Tool
B Expression Selection

Show Al 43 1 2 3 =]
Dynamics / |
Tempo Marks hand damped /
Tempo Alterations © amp
Expressive Text 4 5 B 7 —_
Technique Text n - N
Rehearsal Marks | R -
Miscellaneous
a8 9 1 10 11
1
1
1
52 53 54 55
dolce agitato con brio cantabile
72
Andante poco Y legato _|
Edit Categories... | Miscelaneous: Imported from MusickML
Edit... Duplicate | Delete | IMDVE To j IResett-:u Category j
Create Misc. Expression... | Assign I ﬂ Cancel | Help

2l® |,

Mataw Edit
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Avoiyel To Expression Designer

Expression Designer

Edit Text

Main | Playback I Positioning I

Description: ||m|:u:urteu:| from MusicXML

% Teat: ﬂ
Fort: | iz =] ¥ Fixed Size
ililil [~ Hidden Character Settings... |
Enclosure Shape: INane j Edit... |
" Shape: Edit.. | Create... Select...
¥ Alow horizortal stretching
™ Hidden
0K I Arupa Help
Alopbwvw
x
Edit Text
Main | Playback I Positioning I
Description: Ilrnpl:lrted fram MusicxML

% Text: H

Andante poco Adagio B

Fort: I'I"lrnes New Roman j |12 j [V Fixed Size

nilil [~ Hidden Character Settings... |

Enclosure Shape: IN.:.ne j Edit... |
" Shape: Edit... Create... Select...
¥ Alow horizontal stretching
™ Hidden
QK Arupo Help

nataw OK
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EmoTpe@w oTo nponyoUupevo
B Expression Selection

/
\

Show All 4 3
Dynamics
Ti Marks
szﬁg Ali;raﬁn:-ns hand damped
E ive Text
TedmioueText | |7 5 5 T =77
Rehearsal Marks | — /— ;
Miscellaneous
) o 10 11
]
I
54 55
con brio cantabile
N 72 -
Andante | _ et _| -

Edit Categories. .. | Miscellaneous: Imported from MusickML
Edit... | Duplicate | Delete | IMDVE To j IResett-:u Category j

Create Misc. Expression... | Assign Iﬂ Cancel | Help |

MNataw Assign

AlopBwBnke
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MNa va ypaww &va onuadi
AINAO KAIK NAvw oTn vOTa nou BEAw

EmAgyw
1 2 3 -
Dynamics
Tempo Marks
Tempo Alterations W ﬁ:‘ f
Expressive Text o i
Technique Text
Rehearsal Marks
Miscellaneous mf TIE?J pp
2] 10
ppp Pppp S5
13 14 15 16
sf sfz sff= subito
17 18 149 20
Adagio Adagio »=40 Moderato  acderato (J-c 103

HAd

Edit Categories. .. | Dynamics: Below Staff (Velodty = 49)

Edit... | Duplicate Delete ||MweT.;.

Create Dynamic. .. |

e ]

Cancel |

j IResett-:u Category j

Help |

Assign
TonoBeTnOnkKe




-81-
>Tn ouvéxela Baldw AeykaToUpec Pe Tn PEBODO nou €xel NON NeEPIYPAPEI.
3TNV oucia av OAOKANPWOW TIC MPONYOUHEVEC EVEPYEIEC EXW TEAEIWOEI UE TNV
avTiypan Tng ogAidag pou.

AcC unoBeooupe OTI BEAW va avTiypayww TNV Nnapakatw oeAida



Ta pova kaivouplia oToIxXEia ivai:

Na gn aiveral To HETPO
Main Tool Palette->Mesure Tool

EMNIAEYW TO PETPO BEAW

AINAOG KAIK NAvw TOU.

-82-



>To napabupo rnou avoiyel

-83-

x
Measure Attributes for Measure:
Change Every: I 1 Measure(s)
e} = | ——| ===
Barline: g = == Select... |
Solid Dashed | Invisible Tick Custom
Left Barline: E E — == Select... |
Final Saolid Dashed | Invisible| Custom
[™ override group barlines
Display Behavior
[~ change width: I 2.2225 ™ Begin a new staff system
™ add: I 0 T natih ™ Show full staff & group names
r Extra Space at Beginning: I 0 r Break a multmeasure rest
[~ Extra Space at End: I i ™ Break smart word extensions
= ) )
o FrEie ISth i Nezded j ¥ Indude in measure numbering
Time Signature: ISth if Needed j ™ Allow horizontal split points
[™ Hide cautionary defs, key and
time signatures
Position Motes: ILIsing Beat-Chart Spacing j
[ Evenly across measure ’TI Cancel | Help |
Ll - - -
EniAeyw Time Signature>Always Hide
Measure Attributes
Measure Attributes for Measure: | 17
Change Every: I 1 Measure(s)
Barline: = == Select... |
Salid Dashed | Invisible Tick Custom
Left Barline: E 'E PE IE IE : == Select... |
[XEM Mormal | Double Final Salid Dashed | Invisible| Custom
[T override group barlines
— Display —Behavior

[T Change Width: |2. 2225
[~ add: ||:| to width

[T Exira Space at End: I i

[~ Extra Space at Beginning: I 0

key Signature: Ishnw if Meeded

Time Signature:  |Show if Meeded

Led Lo

(no change)
Show if Needed

Position Motes:

[ Evenly across measure

[~ Begin a new staff system
[~ show full staff & group namez

[ Break a multimeasure rest

[™ Break smart word extensions

¥ Indude in measure numbering

™ Allow horizontal split points

o |

Cancel Help

nataw OK
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ETOIMO

AAAayn kA€1010U OTN HECTH TOU KOHMHATIOU
Main Tool Palette>Clef Tool



-85-

AINAO KAIK O0TO PETPO NOU BEAW va aAAd&w To KAEIDI

>To Nnapabupo nou avoiyel Kavw TIC EMAOYEC HOU

Change Clef

—Clef Selection

(4) |3

(7)

£

3

SR

v
s

WENENS

™ Always Clef Size: I'E o5

—Measure Region

" Measure IlE Through | 15

" Measure I 13 Through End of Piece
{* Measure I 18 To Mext Clef Change

[ Place def after barline

QD (B) (C) (D) (E) (G) (H) (1)
133 7
o) [y
—Show Clef
* When needed
" Mewver

Cancel

Help

MaTtaw OK

‘ETOIHO
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AAAayn onAiIGHOU OTN HECTH TOU KOHHATIOU

Main Tool Palette>Key Signature Tool



-87-
EMAEYw TO PHETPO Mou BEAW

AInAOG kAIK NAVw TOU Kal KAVW O0TO Napadbupo rnou avoiyel TIC pubUioeIC nou BEAwW

x
" =
I

RS
©) B Flat Major .|

IMajnr Key j

—Measure Region

" Measure |12 through II'EJ

" Measure | 1o through end of piece
(+ Measure |1g to next key change

— Transposition Oplions
{* Transpose notes IL.||:| j

" Hold notes to original pitches IEnharmn:unin:aII*r' j
" Hold notes to same staff lines (modally)

[ Transpose all kevs propottionally
¥ Wrap keys If necessary

QK Cancel Help

Mataw OK
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Balw kal TIG enavaAnyeic Je Tn YEB0DO nou €xel NON NePIypaPeEi

TQPA EXOYME OAA TA AMNAPAITHTA E®OAIA I'TA NA ANTITPAWOYME
NMAHPQZ TIZ AYO ZEAIAEZ NOY EXOYN MEXPI ZTIFTMHZ AOOEI

KAAH AIAZKEAAZH



-890-
A@ouU avTiypayape oAOKANpn Tn oeAida npenel va €EAYOUE TNV NAPTA Tou BIoAlou.
EnmiAéyoupe File>Extract Parts

avoiyel avaioyo napadupo



-90-
av dev gugavifovtal AdN Ta €ni yEpouc O6pyava, nataue Generate Parts kai
EMNIAEYOUE TIC NAPTEC Nou BEAOUNE va eEayoupe, €dw Tou BIoAIoU

natape OK

owlOUME TO KAlvoUpIo apxeio Kal dIauopPWVOUHE TN OgAida pag kaTd Ta yvword.



-91-

Suxva xpelaleral va eEayoupe pia napTitoupa (n YEPOC TNG) o€ €IkOvVa, n.X. yid va
€10AYOUME PJOUOIKA napadsiyyaTa o€ hia epyaocia, va QTIaEoupe eknaldeuTIKO UAIKO
KA.

Mnopoupe va eEayoupe oAOKANPN oeAida (] OAEG TIG oeAideg TNG NON JIAHOPPWHEVNG
napTiToupag oc EexwpPIoTa apxeia).

EniAéyoupe Tools>Advanced Tools->Graphics

>1n ouvéxela Graphics=>Export Pages



-92-
Avoiyel To avaAoyo napadbupo

Mnopw va €NIAEEW PHOpPN apxeiou, NOCEC OeAIdeC BEAW va eEayw kal nou va cwbouv
M.x. Type JPEG, Pages From 2 Through 2, Resolution 600dpi

MNatdw OK kal o unoAoyioTnG YHE pWTAEl NOU BEAW va owoel To apxeio nou Oa eEaxOsi.



-93-
Mnopw va €€Eayw kal anoonaocpa napTiTtoupac. Me eniAeyuevo To Graphics Tool

Kavw 81mAo kAIk ndvw oTnv napTiTtoupa kal oxnuaTidw €va nAaiolo niAéyovTag 1o
andéonaopa nou BEAw va €EAyw o€ ikova.

eniAéeyw Export Selection

oTn ouvexela owl{w ONwc Kalr Nnapanavw.



-94-
Ac noupe OTI BEAW va avTiypdyw oTto 35° anod Ta 371 xopika Tou J.S.Bach kai n
napTiToUpa pou va Oeixvel Kata To duvaTov idia JE To NpwTOTUNO.

emnAeyw File>New->Document With Setup Wizard



-95-
EMAEYW TIC KATAAANAEC puBpioEIg

Enopevo
eEMNIAEYw Opyava (€kava Tn auTn TNV €nmiAoyn yia va pou BydAel kaTt’euBeiav To ouoTnua
nou xpeialopat)

Enopevo



ypApw POVO TO OVOUA Hou

Enopevo
EMNIAEYW PETPO, KAIpaka

TEAoG

-96-



-97-

>BNvw Ta nepiola PETPA kal Ta nepiTta Textblocks



Alauop@wvw Tn geAida Pou

-08-
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-100-



-101-



-102-
A€€i KAIK 0TO NAVW OTO TETPAYWVAKI TNG AYKUANG
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Full Group Name > Edit



OK

OK

-104-
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Twpa Jnopw va apxiow va ypaew TIG VOTEC Hou.
H mo anAn pgBodog eival va ypayw Tn conpavo oto layer 1 (katw 0g€1d 0TO KEVTPIKO
napabupo Tou finale)



-106-

TNV aAto oto layer 2



-107-

>TnV apxn Tou TPITOU PETPOU EXW TPEIC PWVEGC. Oa ypdww TNV TpiTn voTa oTo layer 3



-108-



-109-
ETOIMO

OMOIWG YPAPW Tov TevOpo oTo layer 1 kal To ynacco oto layer 2

(oTO TPiTO METPO O TEVOPOC EEKIVAEI OTNV TPITN Kivnon —TIG OUO NPWTEG TIC EXW YPAWEI
oTo KeAIOi TOU 0oA- Ba BAAw nauoeic oTa dUO NPWTA TETAPTA Kal Ba TIC KAvw adpaTeg
HE To [O] opIkpoOv).



-110-



-111-

ETOIPEG Ol VOTEC
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Z€pw NMwc o TITAOC KABe XopikoU ano Ta 371 sival kai n NnpwTn ¢pacn Tou, Apa HUNopw
va BaAw kai Aoyia.
EniAéyw Lyrics Tool

>1n ouvexela Lyrics>Lyrics Window (os naAioTepeg versions: Lyrics>Edit Lyrics)



-113-

>To napabupo rnou avoiyel

ypapw Ta Aoyia
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Kal Xwpilw TIG OUAANABEC e HEOAIEG NAUAEG

EmAéyw Lyrics>Click Assignment



-115-

KavovTtag kKAIk Katw (A navw) ano TIG KaTAAANAEG VOTEG, TONOBETW TIC GUAAABEG



-116-
Av BEAW va ypaww kal deUTePN OTPOPN:
>T10 napabupo Lyrics (Edit Lyrics) sniAéyw
Verse
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Fpa@w Ta kaivouplia Aoyia

Kal Ta «xTundaw» oTtnv napTiTtoupa
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> epvovTag Ta avaloya BeAdakia oTo Oe&i PEPOC TNG GeAidaAg

PuBuilw Tnv anoéoTaon TnG NpwTnG YPAKKNG Kal TIC anooTACEIC AVANEDA OTOUG OTiXOUG
ano TIG VOTEG

KaAn diaokEdaon!!!



-119-
AG noUpe OTI EXOUME va avTlypaWoulue OTNV NApakaTw napTioToupa:



-120-
To KopuaT dev €ival XWPIOPEVO O UETPA, EPEIC OPWG MPEMElI VA TO YPAWOUHE KAVOVIKA
ME YETPA KAl YETA va Ta KpUWOUHE. Oa pnopoucape va opicoupe PETPO 13/4 kal va Ta
YPAWOUME OAa O€ €va PETPO, AAAG O NIo NEPINAOKEC NEPINTWOEIC AUTH N AUon dgv
gival npakTikn. MNa Tnv napouca napTitoupa NPOTEIVW va Tn YPAWOUUE OE YETPA TOU
1/4 kal yeTa va Ta kavoupe aopara.
Opilw Aoinov:



-121-

KAIk oTo Koupni he Ta dUO0 EpwTNUATIKA KAl avoiyel To NnapakaTw



-122-
Opilw TIC CWOTEC TIUEC
Number of Beats: 1, Beat Duration: 4

OK

TEAoG
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Fpapw TIC VOTEC TOU dEI0U XEPIOU OTO NAVW 5ypappo Kal Tou apioTEPOU OTO KATW

SYpappo

>Tn ouvexela enidéyw Selection Tool

EmA&yw O0Ao To ndvw nevraypaguo



-124-
EniAiyw Utilities>Stem Direction>Up

Kal 0Aa Ta oTeAExn oTpEPOVTAl NPOC TA NAVW



-125-
AEe€i KAIK NAvw oTnv NN €NIAEYHEVN NEPIOXN KAl ENIAEYW
Barline>Invisimble



-126-
EniAéyw Mesure Tool

>Tn OUVEXEId KPUBW TO PETPO HE TN YVWOTH anod nponyouueva padnuarta pebodo
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Twpa 6a PeETaPEPW KAMOIEC VOTEC TOU KATW 5ypdappou oTto navw 5ypappo
>T1a Special Tools sniAéyw Note Mover Tool

EmAéyw NoteMover->Cross Staff

Kadvw kAik OTO JETPO TOU Kal ENIAEYW TO Pe# nou BEAW va HETAPEPW
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OTN OUVEXEIQ JE NATNHUEVO TO MOVTIKI O£pVWw TO Pe# oTo S5ypaupo rnou BEAW va To
HETAPEPW

Kavw To id10 Kal yia TIC unoAoineg VOTEG NOU NPENEl va JeTapepBouv

>1n ouvexela Advabced Tools = Special Tools = Special Tool Palette->Tie Tool
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Kavw kAIK navw oTnv Aeykatoupa nou Oev (paiveTal 0woTd

OEPVOVTAC NAVW-KATW Kal 0e€1a-apioTepd Ta KouTdkia TNG, TN S1opfwvw

EniAéyw Reverse Stem Tool

Kavw KAIK OTO HETPO Nou €xel dIaoTAUPOUHEVEG VOTEC



-130-
EMAEYw To HETPO KAl OTN OUVEXEIA TO KATW O€&i KOUTAKI

EmAéyw Beam Angle Tool kal o€pvw To €€ KOUTAKI OTN 0WOTN B€0N

SEPVW TO APIOTEPO KOUTAKI yia va dwow TN owaoTn KAion



-131-
EnavaAauBavw Tn diadikacia onou £xw d1A0TAUPOUHPEVEC VOTEG

To 3° ouoTtnua

OEAW va €xel HOVO €va 5ypappo. ©a kpuww To aAlo.
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>Tn Main Tool Palette cniAcyw Staff Tool

EmAEYw TNV nepioxrn nou BeAw va KpUuYw
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Kavw O0€€i KAIK Navw TnG Kal eNIAEYw
12a. Force Hide Staff: Cutaway
N
12b. Force Hide Staff: Collapse
(1 o naAioTepeg version anAda Hide Staff)
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'ETOIMO
Alapoppwvw Tn oeAida Jou KATa Ta YVWOTA, CUNNANPWV®W Ta OTOIXEIA NOuU Aginouv

T€AoG UANG 6unvou.
KaAn enmituyia!l





